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Abstrakt 

Tato bakalářská práce se zabývá vizualizací míst konání překážkových běhů. V práci 

jsou popsány základy tematické kartografie a postup práce v prostředích ArcGIS Pro, ArcGIS 

Online a ArcGIS Story Map.  

Jedním výsledkem práce je tištěná mapa ve formátu A3, v níž jsou pomocí lokalizo-

vaných diagramů zobrazena místa konání českých překážkových závodů v roce 2019 a po-

čty účastníků těchto závodů. Dvěma doplňkovými kartogramy jsou dále znázorněny počty 

závodů ve státech Evropy v závislosti na výši částky poslané ze státních rozpočtů na sport 

a rekreaci a počty závodů přepočtené na 100 000 obyvatel krajů ČR.  

Druhým výstupem práce je webová mapová aplikace vytvořená v prostředí ArcGIS 

Story Map, v níž mohou uživatelé získat lepší přehled o tematice překážkových běhů. Apli-

kace obsahuje celkem 5 map – mapu českých překážkových závodů, českých tréninkových 

skupin, dvě mapy evropských závodů a mapu trati závodu Spartan Brno. 

 

Klíčová slova 

Tematická mapa, mapa s příběhem, překážkové běhy, ArcGIS, geografické infor-

mační systémy. 

 
 

 

 

  



 

Summary 

This bachelor thesis deals with the visualization of the places where obstacle course 

races were held. In this thesis, there are described thematic cartography basics and operat-

ing procedures in environments of ArcGIS Pro, ArcGIS Online, and ArcGIS Story Map.  

One of the goals of this thesis is a printed map in ISO A3 format. In this map there is 

a diagram map which displays Czech obstacle course races in 2019 and the numbers of 

competitors. By using two choropleth maps there are also illustrated numbers of the Czech 

and European obstacle course races related to numbers of inhabitants and finance sent for 

sport and recreation from state budgets. 

The second goal of this thesis is a web mapping application created in ArcGIS Story 

Map. This app can provide a better overview of the obstacle racing issue. This application 

consists of 5 maps – map of the Czech obstacle course races, map of the Czech training 

groups, two maps of the European races, and map of the Spartan Brno race. 

 

Key words 

Thematic map, Story Map, obstacle course racing, ArcGIS, geographic information 

systems. 
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ÚVOD 

Extrémní závody se v poslední době setkávají s velikou popularitou nejen mezi pro-

fesionálními, ale i rekreačními sportovci. Kromě dlouhých běžeckých či cyklistických závodů 

mezi ně můžeme zařadit i překážkové běhy, které jsou pořádány jen v několika posledních 

letech, a i přesto již dokázaly změnit život tisícovkám lidí. Kromě samotného závodění je 

tento sport charakteristický i velmi zarytou komunitou především „hobby“ účastníků, pro 

které se stalo „překonávání překážek“ především životním stylem. Sama se tomuto sportu 

již několik let věnuji, a proto jsem se jím chtěla zabývat i ve své bakalářské práci, v níž bych 

ho představit širší veřejnosti.  

Ve své bakalářské práci se budu věnovat nejprve představení samotného tématu 

překážkových běhů a rešerši prací pojednávajících o tomto sportu, v další části práce budou 

popsány teoretické principy tematické kartografie a zbývající kapitoly budou již věnovány 

praktické stránce práce, konkrétně sběru dat a posléze popisu tvorby tištěného kartogra-

fického výstupu a webové mapové aplikace.  

Pro tvorbu tištěného výstupu bude použit primárně software ArcGIS Pro, pro další 

úpravy potom grafické programy Inkscape a Adobe Illustrator. Pro vytvoření webové ma-

pové aplikace bude využita šablona Story Map Journal. 

 

 

CÍL A POSTUP PRÁCE 

Cílem práce je vytvoření tištěného kartografického výstupu a webové mapové apli-

kace na téma překážkových běhů. 

Práce sestávala z následujících bodů: 

1. Sběr dat a jejich import do programu ArcGIS Pro 

2. Tvorba tištěného mapového výstupu v programu ArcGIS Pro 

3. Nahrání dat do prostředí ArcGIS Online a jejich editace 

4. Tvorba mapové aplikace v prostředí ArcGIS Story Map 
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1 PŘEKÁŽKOVÉ BĚHY 

1.1 Co jsou překážkové běhy 

Překážkové běhy jsou mladým sportem, který zahrnuje vytrvalostní běh v přírodě a 

překonávání překážek, jeho princip vychází z vojenského tréninku. Nejčastěji se označuje 

anglickou zkratkou OCR – obstacle course racing a ač se oficiálně jedná o sport, pro většinu 

závodníků představuje spíše „životní styl“.  

Překážky na těchto závodech mohou být buď přírodní, nebo uměle vytvořené. Pří-

rodní překážky zahrnují především plavání, brodění bahnem a překonávání terénu, uměle 

vytvořené překážky můžeme rozdělit do několika základních skupin: 

• nošení břemen – například pytlů s pískem, řetězu, kamene, klád apod., 

• ručkování přes připravené konstrukce, 

• balanční překážky, 

• střelbu na cíl,  

• překonávání vysokých stěn,  

• plazení se pod ostnatým drátem, 

• memorovací překážky – nejčastěji zapamatování si několikamístného kódu, který 

je na konci závodu povinné zopakovat. 

V případě nepřekonání překážky je nutné splnit handicap, který se obvykle liší závod 

od závodu. Může to být běžecký okruh navíc, nošení břemene nebo splnění určitého cviku, 

např. na závodech Spartan je to 30 opakování cviku „angličák“ (výskok – dřep – klik – dřep 

– výskok). Handicap by měl být vždy koncipován tak, aby jeho splnění vyžadovalo větší úsilí 

a časové vytížení než samotné překonání překážky. 

Obr. 1 – Závodník na překážce „AIX“ zá-

vodu Gladiator race 



12 

Většinu závodů je možné běžet ve třech kategoriích. Ti nejlepší závodníci běhají 

v kategorii elite. V této kategorii je přísně hlídáno správné překonávání překážek a plnění 

handicapů, závodníci nesmějí přijmout žádnou vnější pomoc (ani lékařskou). Pro výherce 

bývá připravena finanční výhra. Pro účastníky, kteří mají závodní ambice, ale netroufají si na 

start s těmi nejlepšími je kategorie age group. Věkové kategorie v ní jsou rozděleny po 5 

nebo 10 letech. V age group platí stejná pravidla jako v elitní kategorii a obě kategorie jsou 

na mistrovství světa i kontinentálních mistrovstvích. Nejpočetnější kategorie je však na kaž-

dém závodě kategorie open, která je určená pro nejširší spektrum účastníků. V této kate-

gorii je obvykle povoleno vzájemné pomáhání závodníků na překážkách, na některých zá-

vodech není v této kategorii ani měřen čas.  

1.2 Historie sportu 

Za zakladatele tohoto sportu se považuje Joe de Sena, který v roce 2008 organizoval 

vytrvalostní závod jménem Death race. Podstatou tohoto závodu bylo jeho neustálé pro-

dlužování tak dlouho, dokud ze závodu neodstoupilo 90 % všech účastníků. Tento závod se 

shledal s velkým úspěchem, a proto se Joe de Sena rozhodl, že zorganizuje první závod ur-

čený pro větší masu lidí a v roce 2010 uspořádal v americkém Vermontu závod s názvem 

Spartan race (později přejmenovaný na Spartan), čímž dal vzniknout modernímu překážko-

vému sportu. Popularita těchto závodů velmi rychle rostla, postupně začaly vznikat další 

závody od dalších organizátorů. S větším množstvím pořádaných závodů se postupně zvy-

šuje obtížnost překážek a často také samotné délky závodů.  

V České republice byl prvním překážkovým závodem Bahňák v roce 2011, hlavní po-

pularitu ale tento sport začal získávat po prvním závodu Spartan race v Monínci v roce 2013. 

Záhy začaly vznikat další závodní série, mezi ty nejpopulárnější můžeme zařadit: Gladiator 

race, Predator race a Excalibur race. V loňském roce bylo v Česku organizováno kolem sta 

závodů, z nichž měly některé i několik tisíc účastníků. 

1.3 Zastřešující organizace 

Na světové úrovni byla v roce 2014 založena ve švýcarském Lausanne organizace 

FISO (Fédération Internationale de Sports d’Obstacles), česky: Mezinárodní federace pře-

kážkových sportů. Tato nezisková organizace zastřešuje 80 národních federací, které spa-

dají pod čtyři kontinentální organizace. Pod hlavičkou této organizace je každý rok pořá-

dáno mistrovství světa, které se v roce 2020 mělo konat v ruském Sochi. 

Kontinentální organizace jsou: EOSF (The European Obstacle Sports Federation) pro 

Evropu, PAOSF (Pan American Obstacle Sports Federation) pro Severní a Jižní Ameriku, OS-

FAP (The Obstacle Sports Federation of Asia and the Pacific) pro Asii a OSFA (Obstacle Sports 

Federation Africa). EOSF, tedy evropská organizace, zastřešuje Mistrovství Evropy v překáž-

kových bězích a určuje závody, na nichž je možné se na toto mistrovství kvalifikovat. Pod 

EOSF dále spadají, jak již bylo řečeno, národní organizace, pro Českou republiku je to nově 

ČAPS (Česká asociace překážkových sportů). 

Obr. 2 – Logo FISO [1] 
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Samostatná mistrovství pořádá také série závodů Spartan. Závodník z České repub-

liky může po splněné kvalifikaci běžet Mistrovství Evropy ve Spartan, Mistrovství světa ve 

Spartan, Mistrovství světa ve Spartan ULTRA a Mistrovství světa v Trifecta (tratě SPRINT, SU-

PER a BEAST).  

1.4 Závodní tratě 

S vývojem sportu přišla i unifikace délek tratí. Na všech mistrovstvích v překážko-

vých bězích jsou dvě základní tratě, a to 3 a 15 kilometrů. V posledních dvou letech byl na 

některých mistrovstvích organizován i speciální závod s délkou přibližně 100 metrů nazý-

vaný Ninja track. Na jiných, „běžných“, závodech si délku tratě a počet překážek určuje 

každý organizátor sám, závod tedy může mít délku mezi padesáti metry a až několika sty 

kilometry. Například u závodů série Spartan jsou tratě definované takto: SPRINT (5 km + 20 

překážek), SUPER (10 km + 25 překážek), BEAST (21 km + 30 překážek) a poněkud méně 

tradiční je trasa ULTRA (50 km + 60 překážek).  

Další informace o tématu překážkových běhů je možné získat ze zdrojů, z nichž 

bylo čerpáno, při psaní této kapitoly. [1], [2]   

Obr. 3 – Příklad mapy tratě závodu [2] 
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2 REŠERŠE 

Pravděpodobně z důvodu, že jsou překážkové běhy novým sportem, neexistuje to-

lik odborných prací zabývajících se touto tematikou jako v případě tradičnějších sportov-

ních odvětví. Přesto je ale možné najít řadu prací, v nichž se autoři této problematice věno-

vali, a to nejen z pohledu sportovního, ale i například marketingu nebo sociologie. Kromě 

prací věnujících se přímo překážkovým závodům existuje i několik studií o vojenských tré-

nincích na překážkových drahách, z nichž tento sport vznikl. 

Jednou z prací zabývajících se tématem překážkových běhů je článek Obstacle 

Course Challenges: History, Popularity, Performance Demands, Effective Training, and 

Course Design organizace ASEP (American Society of Exercise Physiologists). Autorka v něm 

mimo jiné zjišťovala a vysvětlovala důvody popularity překážkových závodů. Účastníky zá-

vodů můžeme, podle tohoto článku, rozdělit dle jejich motivace do dvou skupin, z nichž 

v první jsou jedinci, pro které je hlavním cílem podat lepší výkon než ostatní závodníci nebo 

alespoň podat výkon stejný ale s menším úsilím, lidé v druhé skupině vyhledávají přede-

vším učení se nových dovedností a dřinu s tím spojenou. Pro mnohé závodníky může být 

stimulem pro vyzkoušení překážkového závodu i určitá potřeba překonání sebe sama, pro 

některé může být závod společenskou událostí, na níž potká spoustu známých a užije si 

zábavu. V neposlední řadě je, dle studie, jedním z důvodů popularity i jistá rozmanitost tré-

ninku, který zahrnuje jak aerobní, tak i anaerobní aktivity, což oproti ostatním sportům vý-

razně snižuje riziko přetrénovanosti. Popisu ideálně složeného tréninku věnovala autorka 

článku velkou pozornost, měl by podle ní být vždy nastavený v závislosti na hlavním závodě, 

na nějž se připravujeme a ideálně by měl obsahovat několik základních částí – intervalové 

běžecké tréninky, silové tréninky, tréninky kombinující cvičení s během a trénink rovnováhy 

a síly úchopu. V poslední části článku autorka popisuje ideální závodní trať, která by měla 

být především bezpečná, co se lokality i překážek týče. [3] 

Velmi zajímavá je diplomová práce Moniky Kozmové na téma Obstacle course 

racing: the effect of obstacles on the total race time during a Spartan Race, jež se zabývá 

studií vlivu trestných cviků na tepovou frekvenci a výsledný závodní čas. Pro svůj výzkum 

vybrala autorka 11 elitních závodníků, jimž měřila během celého závodu Kouty Spartan SU-

PER čas, rychlost a srdeční tep a na vybraných 3 překážkách navíc hodnotila úspěšnost, čas 

strávený na překážce a délku trvání plnění trestného cviku. Podle výsledků této práce ne-

mají trestné cviky negativní vliv na průměrný puls závodníka, z výsledků práce též plyne, že 

průměrný čas strávený na úspěšně zdolané překážce je 23 ± 17 sekund, zatímco při neú-

spěšném pokusu a následném povinném vykonání handicapu stráví na překážce závodník 

průměrně 124 ± 11 sekund. V závěrečné diskuzi se však autorka pozastavuje nad faktem, 

že zatímco závodníci na prvních dvou místech v celkovém pořadí museli dělat každý po 

jednom hendikepu za nesplněnou překážku, což obnášelo 30 opakování cviku „angličák“, 

závodník na třetím místě zvládnul závod zaběhnout „čistě“, a přesto dokončil závod v hor-

ším čase. Závěrem této práce je tedy především fakt, že 30 „angličáků“ je v konečném vý-

sledku zanedbatelný trest a v závodech Spartan tak má větší vliv běžecká složka než sa-

motné překážky. [4] 

Elitní závodník Radek Simandl se ve své diplomové práci věnoval rozdílům ve fy-

zické výkonnosti mezi profesionálními a začínajícími závodníky. Vytvořil 8 testů – výdrž ve 

shybu podhmatem, leh-sedy, běh na 50 metrů s pevným startem, člunkový běh 4 x 10 me-

trů, Cooperův běh, burpee test, výdrž ve stoji jednonož se zavřenýma očima a Jacíkův mo-

torický test – pro výzkum rozdílů v silové vybavenosti, rychlosti, vytrvalosti a obratnosti 

mezi těmito dvěma skupinami. Celkové rozdíly mezi profesionálními a začínajícími 



15 

účastníky výzkumu byly nejmarkantnější v silových a vytrvalostních testech, naopak v rych-

lostních testech byly rozdíly mezi oběma skupinami menší. Výzkumem byla potvrzena spe-

cializace závodníků v překážkových závodech, jež bývají vytrvalostního charakteru s mnoha 

překážkami na jejichž splnění je nezbytné mít kvalitní silový základ. Pro „hobby“ sportovce 

je podle R. Simandla možné se dostat mezi profesionální sportovce, ale tato cesta je velmi 

náročná a dlouhá. Překážkové závody navíc často běhají bývalí profesionálové z jiných 

sportovních odvětví, nejčastěji běžeckého lyžování či atletiky, a nůžky mezi těmito dvěma 

skupinami se ještě více rozevírají. [5] 

Jelikož neexistuje žádné oficiální mapové dílo, jež by reflektovalo místa konání pře-

kážkových závodů nebo je jakkoliv analyzovalo, vzniklo několik map, jejichž autoři nemají 

kartografické vzdělání a k tvorbě využili volně dostupné nástroje.  Takto vytvořené mapy 

mohou tvořit přehledný seznam konaných závodů a pro mnohé uživatele tak mohou přiná-

šet cenný zdroj informací. Jedním z příkladů je nově vzniklá mapa na webových stránkách 

mudlife.cz  [6], druhým může být každoročně vytvářená mapa Jana Štepána [7], kterou autor 

tvoří pro své přátele a známé, již se tomuto sportu věnují. Obě mapy byly vytvořené pomocí 

volně dostupné aplikace Google Map Maker a jsou si velmi podobné. Autoři v nich bodovými 

značkami znázornili místa, na nichž se závody konají, přidali datum konání závodu a u vět-

šiny závodů i odkaz na webové stránky. Z uživatelského hlediska je z mého pohledu přínos-

nější druhá jmenovaná mapa, protože umožňuje filtrovat závody podle jednotlivých měsíců 

a je tak přehlednější než první zmíněná mapa. Nicméně mapa není nijak vyhledatelná a jak 

již bylo řečeno, slouží jen části závodníků, kteří k mapě získali přístup nebo jsou členy face-

bookové skupiny OCR Runners CZ/SK, což výrazně snižuje její využitelnost. 

  

Obr. 4 – Mapa překážkových závodů J. Štěpána 
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3 TEMATICKÁ KARTOGRAFIE 

3.1 Co je tematická mapa 

Podle slovníku VÚGTK je tematická mapa: „mapa zobrazující na podkladu základní 

mapy, popř. na redukovaném podkladu základní mapy nebo obecně geografické mapy 

další přírodní, sociálněekonomické a technické objekty a jevy a jejich vztahy.“ [8] 

3.2 Obsah tematické mapy 

Každá tematická mapa má dvě základní složky – topografický podklad a tematický 

obsah. Topografický obsah nám napomáhá lokalizovat prvky tematického obsahu, obvykle 

to bývá soubor topograficky důležitých prvků, jež byly přejaty generalizací obsahu topo-

grafické mapy. Výběr těchto prvků je závislý na tématu mapy. Topografickým podkladem 

může být:  

• samotná topografická mapa bez úprav, 

• mapa s potlačenými barvami nebo v černobílém provedení, 

• nově vytvořený zjednodušený podklad tvořený prvky tematického obsahu. 

Tematický obsah zahrnuje jeden či více prvků fyziografického nebo socioekonomic-

kého charakteru. Do tematického obsahu můžeme zařadit: 

• vybrané prvky topografického podkladu, 

• jevy zjištěné pozorováním, měřením nebo šetřením, 

• poznatky získané vědeckými postupy. 

V této kapitole bylo vycházeno ze skript V. Voženílka Aplikovaná Kartografie I., 

v nichž je možné se o obsahu tematických map dozvědět více.  [9] 

3.3 Druhy tematických map 

Tematické mapy lze dělit podle různých kritérií, například podle účelu mapy, ob-

sahu, koncepce nebo časového aspektu. 

Podle koncepce můžeme tematické mapy dělit na: 

• analytické – znázorňují nejčastěji jedno téma, přičemž nevyznačují souvislosti mezi 

jevy a znázorňují pouze rozmístění objektů, 

• syntetické – znázorňují více prvků či jevů a ukazují jejich vztahy, 

• komplexní – znázorňují více prvků či jevů a vyjadřují nejen vztahy mezi nimi, ale i 

jejich příčiny a důsledky. [9] 

Podle časového aspektu se dají tematické mapy dělit na: 

• statické mapy – vyjadřují stav mapovaného jevu k určitému časovému okamžiku 

(den, měsíc, rok), 

• dynamické mapy – vyjadřují změny stavu jevu během časového úseku, 

• genetické mapy – vyjadřují vznik a vývoj jevu v čase i prostoru, 

• retrospektivní mapy – vyjadřují rekonstrukci stavu jevů v minulosti, 

• prognostické – vyjadřují, jak by se mohl jev vyvíjet v budoucnosti. [9]  
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Podle vědních disciplín lze tematické mapy dělit dle na: 

• mapy přírodních jevů (fyziogeografické) – znázorňují všechny jevy vzniklé činností 

přírody. Zde můžeme jmenovat mapy fyzické, geologické, hydrologické, geomorfo-

logické aj., 

• mapy společenských jevů (socioekonomické) – znázorňují objekty a jevy, jež vznikly 

na základě antropogenní činnosti. Do této skupiny můžeme zařadit například mapy 

politické, dějepisné, hospodářské, námořní aj.  [10] 

3.4 Zásady tvorby tematické mapy 

Při tvorbě mapy je potřeba dodržovat zásady tvorby, což zajistí vytvoření srozumi-

telné a jednotné mapové dílo, které splňuje všechny náležitosti, jež by mělo mít. 

3.4.1 Zásada jednoty 

Shodné objekty a jevy musejí být znázorněny stejně, všechny části mapy musejí být 

zpracovány jednotně a se shodnou pečlivostí tak, aby na mapě nebyla hůře zpracovaná 

místa. Každá mapa má tři stránky: odbornou, technickou a estetickou.  

3.4.2 Zásada koordinace 

Pro vytvoření kvalitní mapy je potřeba mapu zpracovat nadvakrát. Při prvním zpra-

cování, v tzv. první mapě, se řeší její tematický obsah, během druhého zpracování kartogra-

fické otázky tak, aby mapa výsledná mapa vyhovovala všem požadavkům. 

3.4.3 Zásada jednoduchosti 

Pro zachování přehlednosti mapy a její využitelnosti velkým spektrem uživatelů je 

vhodné používat výrazové prostředky co možná nejhospodárněji. Jednoduchost je třeba 

zachovat u všech částí mapy.  

3.4.4 Zásada prostorové názornosti 

Obsah mapy by měl být přehledný a názorný. V. Voženílek (2001) uvádí: „Prostorová 

diferenciace a dimenze na mapě musí odpovídat skutečnosti a účelu mapy.“ [9] Aby byla 

prostorová přehlednost dodržena, čte se mapa ze dvou vzdáleností. Nejprve je z větší vzdá-

lenosti hodnocena kompozice mapy a poté z menší vzdálenosti samotný obsah. 

3.4.5 Zásada srozumitelnosti 

Při tvorbě mapy je nutné dbát na její srozumitelnost pro široké spektrum čtenářů. 

Ideální mapový klíč by měl reprezentovat skutečné jevy tak, aby čtenář mapy nemusel příliš 

studovat v legendě. Při tvorbě mapy je třeba brát v potaz různé úrovně barvocitu uživatelů 

a jejich rozdílné znalosti tématu. 

3.4.6 Zásada zvýraznění dominant 

Hlavní vyjadřovací prostředek má být vyjádřen graficky nejvýrazněji, v legendě by 

měl být umístěn na začátku. Hlavní téma má být jednoznačně zřetelné z názvu mapy. Je 

zapotřebí postupovat podle pojmového řetězce téma – název – hlavní vyjadřovací prostře-

dek – legenda. 
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3.4.7 Zásada výběru 

Mapa by měla vždy vyjadřovat podstatné jevy na úkor nepodstatných, proto je třeba 

individuálně vybrat objekty a jevy obsahu mapy pro splnění jejího účelu. V názvu musí být 

obsaženo trojí vymezení hlavního tématu mapy: věcné, prostorové a časové. 

3.4.8 Zásada měřítka 

Tato zásada je závislá na účelu mapy. Pro každé měřítko je potřeba jiný výběr prvků 

obsahu mapy, jiná generalizace a jiný postup při sestavování mapy. 

3.4.9 Zásada generalizace 

Bez generalizace by nebylo možné vyjádřit prostorové vazby. Je nutné, aby byla ge-

neralizace vždy provedena s ohledem na účel mapy a měřítko. 

V kapitole „Zásady tvorby tematické mapy“ jsem vycházela ze skript B. Veverky a R. 

Zimové Topografická a Tematická kartografie  [9] a z knihy V. Voženílka a J. Kaňoka Metody 

tematické kartografie: vizualizace prostorových jevů.  [11] 

3.5 Vyjadřovací prostředky tematické kartografie 

Jazyk tematických map je značně odlišný od jazyka map topografických. Patří mezi 

ně prostředky bodové, liniové, plošné. V následujících kapitolách budou některé metody 

tematické kartografie vysvětleny, při jejich psaní jsem vycházela z několika zdrojů, které 

jsou uvedeny u každé podkapitoly zvlášť. 

3.5.1 Tabulky, grafy 

V tematických mapách můžeme použít i tabulky a grafy jako rozšiřující metodu pro 

předání přehledné a systematické informace o mapovaném jevu. Tabulka umožnuje syste-

maticky uspořádat a utřídit informace. Graf obrazně znázorňuje závislosti mezi dvěma pro-

měnnými a je, narozdíl od diagramu, vázán na souřadnicovou osu. [10], [12] 

3.5.2 Diagramy, kartodiagramy 

Pomocí diagramů můžeme do jednoho obrazce znázornit kvalitativní i kvantitativní 

charakteristiku jevu. Diagramy jsou umístěny mimo prostor samotné mapy, v případě, že je 

diagram lokalizován do mapy, nazýváme jej kartodiagramem.  

Kartodiagramy reflektují absolutní hodnoty znázorňovaných jevů pro dílčí územní 

celky, můžeme je dělit na jednoparametrové či víceparametrové, název kartodiagramu ob-

vykle odráží jeho geometrický tvar. Velikost kartodiagramu, obvykle reprezentující kvantitu 

sledovaného jevu, můžeme určit podle velikostních stupnic, a to buď plynulých nebo inter-

valových. [10] 



19 

3.5.3 Kartogramy 

Kartogram můžeme formulovat jako tematickou mapu, jež obsahuje kvantitativní 

údaje relativního charakteru. Jedná se o jednu z nejpoužívanějších metod, jejíž podstatou 

je přepočet statistických dat na předem definovanou územní jednotku, tou může být buď 

administrativní celek nebo území ohraničené jednoduchým geometrickým obrazcem.  

Kartogramy můžeme dělit na více typů. Může to být podle množství zobrazovaných 

charakteristik na kartogramy jednoduché a složené nebo podle způsobu zobrazení sledo-

vaných jevů na kartogramy strukturní, síťové nebo prostorové (někdy též objemové). Jed-

notlivá území můžeme znázornit pomocí barev, barevných odstínů, rastrů apod. Data je 

možné vztáhnout i k jiné charakteristice územní jednotky (např. počtu obyvatel), potom je 

vytvořená mapa tzv. nepravým kartogramem. [10], [13], [14] 

3.6 Barvy v mapách 

Barvy jsou důležitou součástí mapy, proto je potřeba brát zřetel na jejich správné 

užití. J. Kaňok a V. Voženílek (2008) uvádějí, že „barva mapu oživuje, zpřehledňuje a posky-

tuje ji značné možnosti rozlišení.“ Samotné vnímání barev je velmi individuální a zabývá se 

Obr. 6 – Příklad použití kartogramu [10] 

Obr. 5 – Velikostní stupnice [13] 
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jím psychologie barev, různé barvy mohou vyvolávat pocity tepla, hloubky či vzrušivosti. 

Barvy na mapě je možné použít podle zavedeného barevného znakového klíče se standar-

dizovaným barevným provedením (např. geologické mapy) nebo podle barevného klíče 

vlastního.  

Pro větší plochy je vhodné použít méně syté odstíny barev, naopak pro malé plochy 

a liniové a bodové znaky je potřeba užít barvy sytější, což umožní zdůraznit důležité objekty 

nebo jevy zobrazené jako malé plochy a zajistit dobrou čitelnost bodových a liniových 

znaků. 

Téma barev v mapách je velmi obsáhlé, další informace o nich je možné zjistit ve 

zdrojích, z nichž jsem čerpala. Především to bylo z odborného článku J. Kaňoka a V. Vože-

nílka Chyby v mapách: Barvy v mapách v časopisu Geobusiness a ze skript Zásady tvorby 

kartografických výstupů V. Voženílka. [13], [15] 

3.7 Kompozice mapy 

Při tvorbě mapy je potřeba dbát na její vhodnou kompozici. Dle J. Kaňoka a V. Vože-

nílka (2008) je „kompozice jedním z nejdůležitějších aspektů kartografické tvorby, protože 

se významně podílí na zabezpečení rychlého a snadného sděleni prostorových informací 

v mapě.“ [16] Každá mapa musí obsahovat 5 hlavních kompozičních prvků – mapové pole, 

název mapy, legendu, měřítko a tiráž. Kromě těchto prvků může mapa obsahovat i další 

prvky, jejich přidání ale nesmí způsobit špatnou čitelnost či přehlednost.  

V této kapitole jsem vycházela z článku J. Kaňoka a V. Voženílka Chyby v mapách: 

Kompozice mapy v časopisu Geobusiness.  [16]  
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4 POUŽITÁ DATA 

Pro vytvoření topografického podkladu tematické mapy překážkových závodů v ČR 

byla využita digitální vektorovou databázi České republiky ArcČR 500 v 3.3, kterou vytvořila 

firma ARCDATA PRAHA s.r.o. ve spolupráci s Českým statistickým úřadem a Zeměměřickým 

úřadem. ArcČR 500 je v měřítku 1 : 500 000 a obsahuje 2 geodatabáze. V geodatabázi 

ArcCR500_v33.gdb můžeme najít geografické třídy prvků, v AdministrativniCle-

neni_v13.gdb jsou třídy prvků charakterizující administrativní členění republiky. Při tvorbě 

topografického podkladu tematické mapy s kartodiagramy byly využity následující třídy 

prvků: KrajePolygony, Silnice_2016, VodniPlochy, SidlaPlochy, Lesy. [17]  

Pro vizualizaci vodních toků byla použita vrstva Vodstvo databáze Data200, kterou 

vytváří a zdarma distribuuje (ve formátu *.shp) Český úřad zeměměřický a katastrální. [18]  

4.1 Sběr dat o překážkových závodech 

Sběr dat představoval časově poměrně náročnou část práce, neexistuje totiž žádná 

databáze všech překážkových závodů, jež jsou pořádány a data tak musela být sbírána z 

několika veřejně dostupných zdrojů.  

Informace o českých překážkových závodech byla získána z webových stránek or-

ganizace OCRA CZ [19], jež byla loni jedinou zastřešující organizací tohoto sportu na české 

národní úrovni. U českých závodů byla zjišťována nejen minimální délka závodu, datum a 

lokalitu konání, ale i počet překážek, počet účastníků závodu, datum konání v roce 2020 

(pokud se závod měl konat na stejném místě) a informace, zda je součástí akce i dětský 

závod. Informace o místě konání byla u většiny závodů pouze adresně, a proto byla podle 

adresy vyhledána v geoprohlížeči, kde byly zjištěny zeměpisné souřadnice v systému WGS-

84.  

Pro porovnání chtěla autorka připojit i informace o evropských závodech, ale jelikož 

neexistuje žádný seznam, byla využita tabulka kvalifikačních závodů na Mistrovství Evropy 

v překážkových bězích, jež je publikovaná na webových stránkách EOSF. [20] Tato tabulka 

obsahovala jméno závodu, jeho délku, datum a místo konání a kritéria pro kvalifikaci v ka-

tegoriích elite i age group. Poloha závodu byla, stejně jako u českých závodů, zadána adre-

sou, souřadnice tedy byly zjištěny obdobně jako v předchozím případě. Nejjednodušší bylo 

zpracování dat o evropských závodech Spartan v sezóně 2020, všechna data jsou dohleda-

telná podle jednotlivých států na webových stránkách této globální série. U každého pořá-

daného závodu byla přesně zadaná adresa místa startu závodu, jeho souřadnice v systému 

WGS-84 a informace o délce závodu, počtu překážek a datu konání. [2]  

Všechna tato data jsou vztažena k 26.2.2020, po dokončení sběru dat byla ale vět-

šina závodů kvůli pandemii koronaviru zrušena nebo přesunuta na jiné datum. 

Seznam tréninkových skupin byl získán od jejich koordinátorky, paní Veroniky Horné 

Krásné. U těchto dat byla největším problémem skutečnost, že jen minimum tréninkových 

skupin má svou pevnou základnu a velká většina z nich trénuje velmi nepravidelně a na více 

místech, proto bylo velmi obtížné dát do mapy polohu, jež by tréninkovou skupinu jedno-

značně lokalizovala. Nakonec jsou tréninkové skupiny umístěné ve webové mapě jen infor-

mativně ve středu města a podrobné informace je možné získat v odkazu ve vyskakovacím 

okně. Tato data se vztahují k 13.12.2019. 
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Pro lepší představení sportu je ve webové aplikaci ukázána trasa konkrétního zá-

vodu a jeho překážky. Byl vybrán závod Spartan Winter Sprint Brno, který autorka sama bě-

žela, a tudíž měla k dispozici vlastní záznam tratě ze sportovních hodinek s GNNS přijíma-

čem. Celý záznam byl stažený ve formátu *.gpx z webové aplikace Garmin Connect a upra-

ven, protože zaznamenávání trasy nebylo vypnuto ihned po proběhnutí cílem. 

 

  



23 

5 TVORBA TIŠTĚNÉHO VÝSTUPU 

Tištěná mapa překážkových závodů byla zpracovávána v programu ArcGIS Pro a ně-

které části ve vektorových grafických programech Inkscape a Adobe Illustrator. 

5.1 Použité kartografické zobrazení 

Pro mapu Evropy bylo zvoleno Lambersovo ekvivalentní kuželové zobrazení, pro 

mapy ČR zobrazení UTM v zóně 33N.  

5.2 Tvorba podkladové topografické mapy 

V mapě zobrazující diagramy počtů účastníků jednotlivých závodů byla pro lepší 

orientaci vytvořena podkladová mapa, nad níž jsou diagramy zobrazovány. Jak již bylo ře-

čeno v kapitole 4, pro vytvoření podkladové mapy byla použita data z vektorových databází 

ArcČR 500, a Data200.  Mapový klíč byl prvkům přidán v záložce Appearance > Symbology.  

5.2.1 Liniové prvky 

Jako první byla do programu ArcGIS Pro přidána vrstva silnic, z níž byly vybrány 

pouze dálnice, rychlostní silnice a silnice 1. třídy, ostatní prvky byly vzhledem k malému 

měřítku mapy odfiltrovány. Dálnice byly symbolizovány hnědou linií o šířce 1 typografický 

bod (dále jen pt.), rychlostní silnice oranžovou linií šířky 0,8 pt a silnice 1. třídy šedou linií 

šířky 0,6 pt. Žádnému z těchto prvků nebyla přidána lemová linie. Po definování symboliky 

byly některé prvky upraveny tak, aby na mapě nebyly žádné duplicity ani příliš krátké části 

silnic, které by narušovaly jejich výsledný vzhled. 

Druhou importovanou liniovou třídou prvků byly řeky. Z této třídy byly vybrány jen 

větší toky, pro které byly podle šířky toku vytvořeny 3 linie o šířkách 0,8, 0,6 a 0,4 pt. Barva 

linie byla zvolena tak, aby korespondovala s lemovou linií vodních ploch. 

Program ArcGIS Pro umožňuje mimo nastavení barvy a tloušťky čar i editaci zakon-

čení linií, jejich celistvost, odsazení, či přepisování, tyto funkce však při práci nebyly použity. 

5.2.2 Plošné prvky 

Prvními přidanými plošnými prvky byly hranice krajů ČR ze třídy prvků KrajePo-

lygony. Krajům byla přidělena šedá lemová linie šířky 1 pt, výplň přidána nebyla.  

Polygonové třídě lesů byla přidělena zelená barva malé sytosti. Při výběru barvy 

bylo především dbáno na to, aby nebyla příliš výrazná, což by mohlo mít negativní vliv na 

výsledný vzhled a způsobit menší zdůraznění tematických prvků mapy. 

Pro znázornění obcí byla nejprve použita polygonová třída prvků ObcePolygony, ta 

však zahrnuje celé katastrální území, včetně neobydlených částí jako jsou například lesy, 

některé obce tak vypadají obdobně velké jako krajská města. Po zjištění tohoto problému 

autorka přemýšlela nad možností použití bodových znaků pro menší města a ponechání 

polygonové třídy prvků pouze pro města krajská, nakonec se ale rozhodla pro užití již zmí-

něné polygonové třídy SidlaPlochy, která obsahuje jen zastavěné části území obcí, jejich 

vzhled tak vypadá reálněji a nedochází ke konfliktu s body znázorňujícími místa pořádání 

více překážkových závodů. V mapě jsou znázorněny pouze obce s více než 15 000 obyvateli, 
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menší obce byly příkazem Definion Query skryty. Této třídě prvků byla přidělena červená 

výplň bez lemové linie.  

Posledním znázorňovaným prvkem byla třída vodních ploch, která byla symbolizo-

vána modrou barvou s lemovou linií šířky 0,5 pt tmavšího odstínu modré barvy. 

5.3 Nahrání dat do programu ArcGIS Pro 

Všechna data o závodech byla zpracována v tabulkách programu Excel a uložena ve 

formátu *.csv. Pro import těchto dat byla použita funkce Display XY Data, v níž byl nastaven 

souřadnicový systém a bylo vybráno pole tříd prvků, v nichž byly souřadnice obsaženy. 

5.4 Tvorba kartodiagramu 

Jako hlavní metoda tištěného výstupu práce byla zvolena metoda kartodiagramu, 

která ve výsledné mapě znázorňuje podíl účastníků na jednotlivých českých závodech. Po-

loha závodu byla určena na místo startu, které bylo uvedeno v propozicích. Na velké většině 

míst se nicméně z organizačních důvodů koná více než jeden závod, a proto musely být 

kartodiagramy odsunuty tak, aby se vzájemně nepřekrývaly. Pro následné snazší umístění 

popisků chtěla autorka tuto činnost provést před samotnou tvorbou diagramů funkcí Dis-

perse markers, po každém spuštění této funkce však přestal celý program ArcGIS Pro rea-

govat a po pár desítkách vteřin se vypnul, tudíž bylo odsunutí provedeno až automatickým 

procesem při tvorbě kartodiagramů a ručně upraveno v programu Illustrator. 

Diagramy byly vytvořeny funkcí Symbology > Charts > Pie charts. Každý kartodia-

gram byl rozdělen podílem počtu mužů a žen, kteří doběhli daný závod, velikost kartodia-

gramů byla dána součtem obou těchto hodnot. Z důvodu velké rozptýlenosti dat – mezi 13 

a 4431 účastníky jednoho závodu – byly počty účastníků odmocněny, čímž bylo zamezeno 

přílišnému rozdílu ve velikosti jednotlivých diagramů, jejich špatné přehlednosti a čitel-

nosti. Jednotlivým částem kartodiagramů byla přidělena červená barva pro podíl žen a 

modrá barva pro podíl mužů na konkrétním závodě, dělení bylo nastaveno ve směru hodi-

nových ručiček s počátkem na 12. hodině. Velikost nejmenšího diagramu byla 8 pt. 

Pro možnost rozlišení organizátora závodu byly do prostoru diagramů přidány 

zkratky jmen pořadatelů a pro rozlišení měsíce, v němž byl závod pořádán, byl obvod dia-

gramu barevně zvýrazněn. 

Obr. 7 – Výsledný značkový klíč 
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5.5 Tvorba kartogramů 

Pro doplnění informací byly v tištěné části práce vytvořeny dva nepravé kartogramy. 

Prvním z nich byl nepravý kartogram reflektující podíl počtu závodů a částky určené na 

sport a rekreaci vydané ze státních rozpočtů evropských zemí. Pro tvorbu byly použity bo-

dové třídy prvků evropských kvalifikačních závodů a evropských závodů Spartan. Pro zjiš-

tění počtu závodů v jednotlivých zemích byla použita funkce Spatial Join a vztah Comple-

tely within. Data o financích určených na sport byla stažena z webových stránek Eurostat 

[21], upravena v programu Excel a připojena funkcí Add Join k polygonové třídě evropských 

států. Funkcí Calculate Field byly následně vypočítány počty závodů na 1 milion eur posla-

ných ze státních rozpočtů. 

 Data dosahovala hodnot od 1,7 do 70,0 závodů na 1 milion Eur, průměr měl hodnotu 

15,7 se směrodatnou odchylkou 15,4. Data byla nejprve Jenksovou metodou rozdělena do 

6 tříd, meze intervalů byly následně manuálně upraveny, rozdělení do tříd a histogram hod-

not je na Obr. 9.  

 

Obr. 8 – Vzhled výsledného diagramu 

Obr. 9 – Histogram dat a jejich rozložení do 

tříd pro tvorbu 1. kartogramu 



26 

Druhý nepravý kartogram znázorňuje počet závodů sezóny 2019 na 100 000 obyva-

tel krajů ČR. Stejně jako u tvorby prvního kartogramu byl nejprve funkcí Spatial Join určen 

počet závodů v krajích ČR a následně byl pomocí Calculate Field vypočítán počet závodů 

připadajících na 1000 km2 rozlohy krajů ČR. Data nabývala hodnot od 0,17 do 3,26 závodů 

na 100 000 obyvatel, jejich průměr byl 1,19 se směrodatnou odchylkou průměru 1,83. Data 

byla Jenksovou metodou rozdělena do 5 tříd, meze intervalů byly následně manuálně upra-

veny. Histogram dat a rozložení do tříd je na Obr. 10.  

Kartogramy byly vytvořeny v kartě Appearance > Symbology > Graduated Colors, 

v řádku Colours byly upraveny barvy a ve sloupcích Label přepsány popisy jednotlivých tříd. 

5.6 Tvorba popisů 

V mapě kartodiagramů českých závodů byly pomocí funkce Label přidány názvy 

měst. Jménům krajských měst byl nastaven font Myriad Black SemiCondensed a velikost 9 

pt, ostatní města byla přidána v tomtéž fontu, ale jejich velikost činila 7 pt. Po automatické 

generaci popisů měst a nastavení vzhledu písma byly z popisků vytvořeny anotace – Con-

vert Labels to Annotation, které umožňují editovat jednotlivé texty, měnit jejich polohu, pří-

padně i font, velikost, zarovnání atd. Písmo by mělo být upraveno tak, aby vzájemně neko-

lidovalo s jinými popisky nebo jinými prvky kvůli nimž by mohlo docházet ke špatné čitel-

nosti. Další řešenou částí umístění popisu byla kontrola, zda nevzniká v některém místě ne-

jednoznačnost popisů. 

Pro lepší orientaci ve znázorňovaných závodech, resp. kartodiagramech, byla při-

dána ke každému závodu zkratka organizátora daného závodu. Tyto popisky byly přidány 

fontem Myriad Bold, velikost byla 6 typografických bodů a pro jejich snadné čtení byla zvo-

lena bílá barva. Seznam těchto zkratek je ve spodní části výsledného tištěného výstupu.  

Obr. 10 – Histogram dat a jejich rozložení 

do intervalů pro tvorbu 2.  kartogramu 
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5.7 Tvorba výsledné kompozice 

Po připravení všech map byl funkcí Insert > New Layout > ISO Landscape A3 vytvo-

řen nový mapový list rozměru A3 na šířku. Do kompozice byl nejprve přidán rám kartodia-

gramu v měřítku 1 : 1 500 000 (mapové pole 1), posléze i nepravý kartogram evropských 

závodů v měřítku 1 : 75 000 000 (mapové pole 2) a kartogram reflektující počty závodů 

v krajích ČR v měřítku 1 : 7 000 000 (mapové pole 3). Všechny mapové rámy byly přidány 

v kartě Insert > Map Frame. Schéma výsledné kompozice je k nahlédnutí na Obr. 11. 

Kromě základních kompozičních prvků byly nakonec přidány i grafické obrázky zá-

vodníků na různých překážkách vytvořené v programu Inkscape a krátký odstavec s vysvět-

lením „Co jsou překážkové běhy“. Směrovka do výsledné kompozice přidána nebyla. 

5.7.1 Název 

Výsledné mapové kompozici byl v záložce Insert > Dynamic text > Map Title přidán 

název. Situován byl do pravého horního rohu, jeho velikost byla nastavena na 60 pt, zvolený 

font byl Tw Cen MT Condensed Extra Bold. Při tvorbě názvu je vhodné se vyhnout slovům 

„mapa“ nebo „plán“, nakonec autorka zvolila „Překážkové běhy v Česku a Evropě v roce 

2019“. Doplňkovým kartogramům byly přidány názvy též ve fontu Tw Cen MT Condensed 

Extra Bold, ale o velikosti 13 typografických bodů. 

5.7.2 Legenda 

Legenda byla vygenerována v záložce Insert > Legend a následně byla pro lepší 

editaci zvolena možnost Convert to graphics a následně Ungroup, čímž byla legenda upra-

vena na jednotlivé prvky, které je možné následně upravit. Nicméně, v takto vytvořené le-

gendě nevypadají především kartodiagramy příliš vzhledně, a proto byla tato část legendy 

upravena v programu Adobe Illustrator. 

Obr. 11 – Schéma výsledné kompozice 
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Kromě těchto prvků byl přidán i seznam zkratek jmen organizátorů závodů vepsa-

ných v kartodiagramech. 

5.7.3 Přidání měřítek 

Všem mapám byla v záložce Insert > Dynamic Text > Map scale přidána číselná mě-

řítka. Zde bylo potřeba upravit malým přepsáním kódu jejich vzhled tak, aby odpovídal čes-

kým konvencím a obsahoval mezeru před i za dvojtečkou. Pro měřítka byl zvolen font Tw 

Cen MT Condensed, měřítko mapového pole 1 mělo velikost 16 typografických bodů, mě-

řítko kartogramů (map. polí 2 a 3) 12 pt. Pro mapové pole 1 (kartodiagram) bylo v kartě In-

sert > Scale Bar přidáno i měřítko grafické. 

5.7.4 Tiráž 

Posledním přidaným prvkem byla tiráž. Do tiráže bylo přidáno jméno autorky, da-

tum a místo vydání a informace o podkladových datech. Byla umístěna do pravého dolního 

rohu a, stejně jako legendě a názvu, jí byl přidělen font Tw Cen MT Condensed, tentokrát o 

velikosti 10 pt.   

Obr. 12 – Výsledná legenda 
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6 TVORBA WEBOVÉ MAPOVÉ APLIKACE 

Pro tvorbu webové aplikace byl využit nástroj ArcGIS Story Maps, který umožňuje 

propojení map, příběhu, obrázků a dalšího multimediálního obsahu. Ve výsledné aplikaci je 

celkem 5 map – mapa tréninkových skupin v ČR, mapa českých závodů v roce 2019, mapa 

evropských závodů, mapa závodů Spartan v Evropě a mapa tratě závodu Spartan Brno. 

Všechny mapy byly nejprve vytvořeny a připraveny v prostředí ArcGIS Online a až 

následně byla vytvořena webová mapová aplikace. 

6.1 ArcGIS Online 

ArcGIS Online je nástroj vytvořený na cloudové platformě společností Esri. Je určen 

pro publikaci, sdílení, analýzu a prohlížení dat prostřednictvím internetu. Umožňuje vytvá-

řet webové mapy, 3D webové scény a webové mapové aplikace, data vytvořená v tomto 

prostředí je možné sdílet v rámci skupiny organizace, veřejně nebo je nechat skrytá pouze 

pro potřeby autora. ArcGIS Online je dostupný nejen v klasické desktopové verzi, ale i na 

jiných zařízeních s operačními systémy Windows, Android nebo iOS.  

Při práci v prostředí ArcGIS Online byly informace o některých funkcích dohledávány 

v dokumentaci vydané společností Esri. [22] 

6.1.1 Nahrání dat do prostředí ArcGIS Online 

Pro práci na mapové aplikaci bylo nejprve nutné nahrát data z programu ArcGIS Pro 

do prostředí ArcGIS Online. Tato činnost byla provedena funkcí Share > Web Layer > Publish 

Web Layer. Publikovaným vrstvám bylo přiděleno jméno, krátké shrnutí jejich obsahu a klí-

čová slova, pro snadné dohledání, jako typ nahrávaných dat byla zvolena možnost Feature 

layer, která nahraje vektorovou vrstvu prvků, jež se bude zobrazovat nad podkladovou ma-

pou a umožní její další editování a tvorbu dotazů na prvky vrstvy. Kromě publikace vrstvy 

prvků nabízí ArcGIS Pro možnost nahrání vrstvy dlaždic, Tile layer, nebo vrstvy vektorových 

dlaždic, Vector tile layer. Před samotnou publikací vrstev na server bylo nejprve nutné za-

nalyzovat, zda neobsahují problémy, jež by mohly bránit jejich správnému nahrání. Na-

hrané vrstvy byly zkontrolovány a uloženy jako webové mapy. Před samotnou tvorbou we-

bové aplikace byly mapy upraveny pro jejich správné zobrazování v mapové aplikaci. 

6.1.2 Nastavení podkladové mapy 

ArcGIS Online nabízí deset možností zobrazení podkladové mapy, přičemž výběr 

jedné z nich závisí na povaze zobrazovaných dat a osobních preferencích. Pro svou práci 

zvolila autorka 3 různé podkladové mapy. Pro mapu tréninkových skupin, českých a evrop-

ských závodů to byla topografická mapa, jíž aplikace nabízí ve výchozím nastavení. V mapě 

série Spartan v Evropě měly být především vizualizovány státy a regiony, v nichž se závody 

běhají, jako podkladová mapa se tedy nabízelo šedé plátno, které obsahuje pouze hranice 

států, popisy jejich názvů a při větším přiblížení mapy i vybraná města. Státy i regiony, 

v nichž se závody běhají tak lépe vynikly. Pro poslední mapu, zobrazení trasy závodu Spar-

tan Brno, byly vybrány letecké snímky, protože lépe a „živěji“ vykreslovaly představu o zá-

vodě. 
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6.1.3 Nastavení symboliky 

Podobně jako v programu ArcGIS Pro lze i v ArcGIS Online nastavit symboliku zobra-

zování vybraných tříd prvků. Po exportu dat z ArcGIS Pro se přejímá symbolika z tohoto pro-

středí. Vytvořené kartodiagramy ale do ArcGIS Online nahrát nejdou, a proto musely být 

vytvořeny až posléze. Symbolika, kterou ArcGIS Online nabízí, je poměrně široká, ve výcho-

zím nastavení se zobrazuje pouze poloha prvků, po vybrání pole atributů ale aplikace na-

bídne několik možností jejich vizualizace – například heat map, kartodiagramy, unique va-

lues apod. Seznam všech způsobů vizualizace dat a návodu na jejich použití je v ArcGIS Do-

cumentation. [22] 

Pro vytvoření kartodiagramů je potřeba nejprve vybrat atribut, na základě nějž bude 

kartodiagram vytvořen a následně zvolit možnost Counts and Amount (size). Jejich další 

editace je pod volbou Options, kde lze nastavit počet tříd, klasifikovat data a upravit vzhled. 

Při tvorbě kartodiagramů reflektujících počty závodů v jednotlivých krajích byla data meto-

dou přirozených zlomů rozdělena do 4 tříd a jelikož nebyl v jednom kraji organizován ani 

jeden závod, byla použita funkce Draw features with out of range or no value, což umožnilo 

jinou stylizaci diagramu v tomto kraji. Následně byla upravena legenda a vzhled samotných 

kartodiagramů – minimální a maximální velikost, viditelný rozsah a barva.  

6.1.4 Nastavení vyskakovací oken 

Vyskakovací okna (pop-ups) přinášejí lepší přehled o zobrazovaných vektorových 

datech, které by jinak nemusela být jednoznačná. Mohou obsahovat text, seznam polí, 

grafy, obrázky, odkazy a jiné přílohy. Vzhledem k poměrně velkému množství bodových 

prvků, jež aplikace obsahovala, byla, pro lepší orientaci, u některých map vyskakovací okna 

využita.  

Ve výchozím nastavení obsahují vyskakovací okna seznam všech atributů polí a je-

jich názvů, čísla jsou zobrazována ve výchozím formátování (Obr. 13). Pro práci s mapou ale 

často není nutné vypisovat všechny atributy, navíc názvy některých atributů mohou být pro 

člověka, který data nevytvářel, nesrozumitelné. Vzhledem k těmto skutečnostem bylo vy-

skakovací okno funkcí Configure Pop-up nastaveno do přehlednější formy.  

 

Obr. 13 – Rozdělení dat do tříd pro tvorbu kartodi-

agramů počtu českých závodů v krajích ČR 
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Nastavení obsahu vyskakovacího okna může být provedeno čtyřmi způsoby: 

• zobrazení jednoduchého seznamu atributů polí, v němž je možné vybrat zobrazo-

vané atributy a přiřadit jim alternativní jméno, které bude srozumitelné pro 

všechny uživatele, nastavit formátování čísel a určit pořadí atributů, 

• popis z jednoho pole, které je možné vybrat a upravit dle vlastních požadavků, 

• vlastní nastavení, jež se dá provést buď pomocí jednoduchého editoru, jenž apli-

kace nabízí, nebo upravením HTML kódu pro sofistikovanější úpravy,  

• nebo je možné použít vyskakovací okno bez hodnot polí atributů. 

Do vyskakovacího okna je možné přidat kromě názvu a samotného obsahu i média, 

například obrázek nebo jeden ze 4 nabízených druhů grafů. Pro přidání obrázku se do pří-

slušného řádku zadává jeho URL adresa, která může být zadána ručně v případě, že by měl 

být obrázek stejný ve všech vyskakovacích oknech, nebo jako hodnota pole atributu, pokud 

bychom chtěli pro každý prvek jiný obrázek.  Přidání grafu vyžaduje nejprve volbu typu mezi 

grafem výsečovým, pruhovým, sloupcovým nebo spojnicovým, následně výběr polí atri-

butů, z nichž bude graf vytvořen a případně pole pro normalizaci grafu. Stejně jako obrázku 

je i grafu možné přidat název a popisek. 

Obr. 14 – Zobrazení vyskakovacího okna ve 

výchozím nastavení 
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Velikost vyskakovacích oken lze upravit ve zdrojovém kódu aplikace, v rámci práce 

však tato úprava provedena nebyla. 

6.1.5 Mapové poznámky 

Při tvorbě mapy zobrazující trasu závodu Spartan Brno byly pro vizualizaci překážek 

použity mapové poznámky, které umožňují vytvořit novou vrstvu přímo v prostředí ArcGIS 

Online. Jejich přidání se provádí přes Add > Add Map Notes. Mapové poznámky mohou být 

ve formě bodů, textu, linií nebo polygonů a při jejich tvorbě je možné přidat do jedné vrstvy 

více různých druhů prvků. Ve vyskakovacím okně mohou obsahovat název, popis a obrázek 

či odkaz na webovou stránku.  

 

Obr. 15 – Možné zobrazení vyskakovacího okna 

po úpravách 
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6.2 ArcGIS Story Map 

Jak již bylo řečeno v úvodu kapitoly, pro vytvoření webové aplikace byl využit ná-

stroj Story Map od společnosti Esri. Aplikace nabízí sedm šablon, v nichž je možné Story 

Map vytvořit, volba jedné ze šablon je nutná již v prvním kroku tvorby mapové aplikace a 

závisí především na typu dat, jež budou v aplikaci prezentována. V případě nejistoty ve 

volbě šablony se nabízí možnost Zeptejte se profesionálů, která pomocí několika otázek 

pomůže s výběrem vhodné aplikace. 

 

6.2.1 Story Map Journal 

Podle [23] je šablona Story Map Journal ideální pro kombinaci vyprávění příběhu 

s mapami a dalším obsahem. Aplikace je rozdělena na sekce, z nichž každá obsahuje hlavní 

úroveň a posuvný panel, který může být buď postranní nebo plovoucí, jak je znázorněno na 

Obr. 17. Pro tvorbu aplikace byl zvolen postranní panel, protože je vhodnější pro příběhy 

s větším množstvím textu a obrázků. Do hlavní úrovně lze přidat mapu, obrázek, video nebo 

webovou stránku, v postranním panelu může být kromě samotného textu i malý obrázek, 

video, odkaz nebo tlačítko akce příběhu.  

 

 

 

 

Obr. 16 – Šablony StoryMaps 
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6.2.2 Založení Story Map 

Pro založení příběhu je nutné mu přidělit název a nastavit domovskou sekci, která 

se bude zobrazovat při otevření aplikace. Domovská sekce musí obsahovat mapu, obrázek, 

video nebo webovou stránku v hlavní části a úvodní text v posuvném panelu.  

6.2.3 Editace aplikace 

Přidání další sekce se provádí přes Přidat část. Všechna přidání jsou totožná se za-

kládáním sekce domovské. 

Do hlavní úrovně lze přidat mapu, obrázek, video nebo webovou stránku. Pro přidání 

mapy je možné vybrat jakoukoliv mapu z ArcGIS Online nebo vytvořit mapu novou. Po jejím 

výběru či vytvoření je vhodné nastavit její výchozí zobrazení a zobrazovaný obsah. Pro kaž-

dou mapu můžeme přidat legendu, malou přehledovou mapu a vyhledávač adres a míst. 

Takto vygenerovaná legenda ale není příliš vzhledná, a proto je žádoucí upravit zdrojový 

kód aplikace pro její lepší čitelnost.  

Po nastavení hlavní úrovně je potřeba přidat obsah do postranního panelu ve druhé 

části dialogového okna. Postranní panel může zahrnovat text, malé obrázky, grafy, videa, 

odkazy nebo akce příběhu. Celý obsah lze jednoduše upravit pomocí funkcí, které okno na-

bízí. Pro sofistikovanější požadavky je možné okno přepnout na zobrazení zdrojového HTML 

kódu, který lze upravovat. 

6.2.4 Akce příběhu 

Akce příběhu (Action buttons) propojují postranní panel s hlavní úrovní příběhu, 

čímž zlepšují interaktivitu aplikace. Mohou pomoci ovládat mapu v hlavní úrovni, zapínat 

nebo vypínat její vrstvy, přepnout mapu do jiné polohy, zobrazit vyskakovací okno nebo 

tyto možnosti zkombinovat. Kromě změny zobrazení již přidané mapy je možné pomocí 

nich otevřít v hlavní úrovni mapu novou, případně otevřít obrázek, video či webovou 

stránku. 

Obr. 17 – Možnosti umístění postranního panelu ve Story Map Journal 
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Akce příběhu přidává se označením libovolného textu a volbou nově zaktivované 

možnosti Změnit obsah hlavní úrovně (druhá ikona na Obr. 18). 

Text, který obsahuje akci příběhu, se v postranním panelu ztuční a podtrhne přeru-

šovanou čarou, nepůsobí však příliš výrazně, a proto mu byl úpravou zdrojového kódu změ-

něn vzhled – dvěma novými třídami byla v kódu definována dvě různá tlačítka pro ovládání 

Akcí příběhu. 

6.2.5  Nastavení vzhledu Story Map 

Aplikaci je možné nastavit podle osobních preferencí vzhled, je k dispozici editace 

rozvržení aplikace – úprava umístění postranního panelu na pravou nebo levou stranu a 

jeho velikosti. Dále se nabízí upravení barevného motivu celé aplikace (Obr. 19) a použitého 

fontu. Všechny tyto vlastnosti lze editovat i upravením Java skriptu, ale pro uživatele, již 

tento jazyk neovládají, jsou k dispozici tyto předpřipravené motivy.  

 

Více o založení a editaci Story Map Journal je možné se dozvědět v tutoriálu vyda-

ném společností Esri, z něhož byly při práci čerpány informace. [23] 

Obr. 18 – Vložení Akce příběhu 

Obr. 19 – Nabízené motivy aplikace񞏷 
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6.2.6 Výsledná aplikace 

Výsledná aplikace je k nahlédnutí zde.  

  

Obr. 21 – Vzhled výsledné aplikace 1 

Obr. 20 – Vzhled výsledné aplikace 2 

https://arcg.is/1uTnuy
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7 ANALÝZA DAT 
Vzhledem k většímu množství dat, jež se podařilo získat, bylo možné provést menší 

analýzu dat, která týká českých závodů organizovaných v roce 2019. Celkem byly získány 

informace o 99 závodech 23 organizátorů. Tabulka s daty, z níž bylo vycházeno je přílohou 

této práce. 

7.1 Trasy závodů 

7.1.1 Délka tratě 

Délka je jedním z aspektů, podle nějž si závod jeho budoucí účastníci vybírají. V ka-

pitole 1.4 byly popsány standardní délky tratí, většina organizátorů se jimi však neřídí a 

délku závodu volí podle svých možností, lokality a cílové skupiny závodníků. V propozicích 

je vždy udaná minimální délka, kterou by měl závod mít, z tohoto údaje vycházejí i násle-

dující statistiky.  

Nejkratšími závody byly dvě 100metrové tratě – první v rámci Mistrovství ČR a druhá 

Gladiator race challenge v Hradci Králové. Jako nejdelší závod by se dal označit přerovský 

Geroy Ultimatum, což byl 12hodinový vytrvalostní závod, při němž bylo cílem uběhnout bě-

hem tohoto času co největší počet kilometrů. Do tabulky ho nicméně nebylo jak zanést, 

protože vítěz tohoto závodu uběhnul celkem 72 kilometrů, zatímco poslední závodník 

pouze 24 kilometrů. Pokud bychom tedy hodnotili jen podle délky, jež musí pro dokončení 

závodů dojít všichni účastníci, byl by nejdelším závodem Lipno Spartan BEAST, jehož trať 

měla délku 21 kilometrů. Nejvíce závodů – 27 – mělo délku mezi 5,6 a 7,0 kilometry, z čehož 

22 z nich mělo minimální garantovanou délku 6,0 kilometrů. Histogram rozložení závodů 

dle jejich délek je na Obr. 22. 

 

  

Obr. 22 – Histogram rozdělení závodů dle jejich délek 
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Z pohledu závodních sérií jsou těmi nejdelšími Heroes race, jenž se koná v Hradci 

nad Moravicí, a Spartan s průměrnou délku závodu 10,7 a 10,6 kilometru, nejkratší byly na-

opak závody Bahňák a Seal’s run. Průměrný závod měl délku 6,9 kilometru. 

  

Obr. 23 – Graf průměrných délek závodů dle organizátorů 
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7.1.2 Počet překážek 

Pro mnohé závodníky může být klíčovým faktorem pro výběr závodu také počet 

překážek, které na něm mohou očekávat. Především elitní závodníci se již v dnešní době 

specializují buď na závody s větším množstvím překážek nebo na závody, v nichž je překá-

žek méně a více záleží na běžeckém výkonu. Další zkoumanou veličinou byl tedy počet pře-

kážek na 1 kilometr závodu. Nejvíce překážek mají v přepočtu zpravidla kratší závody, které 

by měly na 1 kilometru až 70 překážek (již zmíněný závod na 100 metrů v rámci MČR), v prů-

měru všech závodů připadá na jeden kilometr 4,98 překážek. 

7.2 Lokality závodů 

Místa konání závodů jsou často velmi specifická, kromě skiareálů či přírodních ob-

lastí se některé běhy konají i v obydlených částech měst, příkladem by mohly být závody 

Spartan, které závodníky provedly historickým centrem Kutné Hory nebo závody Urban 

Challenge, jež jsou situovány pouze do měst.  

  

Obr. 24 – Graf průměrného počtu překážek na 1 km závodu dle organizátorů 
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7.2.1 Rozdělení závodů dle krajů  

Pro zjištění počtu závodů v jednotlivých krajích byla použita třída prvků KrajePo-

lygony z ArcČR 500 [17] a funkce Spatial Join, v níž bylo na základě polohy, vztahem Com-

pletely Within, vypočítáno množství pořádaných závodů v jednotlivých krajích. Tato data 

byla použita i pro tvorbu kartogramu znázorňujícího počet závodů na 1000 km2 plochy krajů 

ČR. Nejvíce závodů – 17 – bylo zorganizováno v Pardubickém kraji, naopak v kraji Zlínském 

nebyl v roce 2019 závod ani jeden. 

 

Kraj závodu Počet závodů 

Hlavní město Praha 4 

Jihočeský kraj 3 

Jihomoravský kraj 2 

Karlovarský kraj 4 

Kraj Vysočina 6 

Královéhradecký kraj 10 

Liberecký kraj 8 

Moravskoslezský kraj 11 

Olomoucký kraj 5 

Pardubický kraj 17 

Plzeňský kraj 12 

Středočeský kraj 15 

Ústecký kraj 3 

Zlínský kraj 0 

 

7.2.2 Vzdálenost od větších měst 

Další zjišťovanou informací byla vzdálenost místa startu od měst s více než 15 000 

obyvateli. Pro zjištění této informace byla využita třída prvků ObcePolygony z databáze 

ArcČR 500.  Při této analýze byla použita nejprve funkce Buffer, která vytvořila v okolí měst 

obalové zóny požadovaných velikostí. Následně byla použita funkce Select by Location díky 

níž byly vybrány prvky, které ležely ve sledované zóně. Jako vztah mezi bodovou třídou 

Tab. 1 – Počty závodů v krajích ČR 



41 

českých závodů a vytvořenou obalovou zónou byl zvolen Completely Within. Ze všech zá-

vodů bylo 48 % z nich ve vzdálenosti menší než 5 kilometrů od všech větších měst 

Použitím stejné funkce a změnou třídy na SidlaPlochy bylo zjištěno, že celkem 21 

závodů mělo start přímo v katastrálním území těchto měst.  

7.2.3 Nadmořské výšky startů závodů 

K datům byla pro získání nadmořských výšek připojena WMS služba DMR 5G. Ná-

sledně byla použita funkce Extract Values to Points z toolboxu Spatial Analyst, která extra-

huje hodnoty buněk rastru podle bodové třídy prvků a zaznamenává je do nově automa-

ticky vytvořeného pole „RASTERVALU".  Takto zjištěné nadmořské výšky se týkají míst startu 

dotčených závodů a jsou ve výškovém systému Balt po vyrovnání. DMR 5G má úplnou 

střední chybu výšky 0,18 m v odkrytém a 0,3 m v zalesněném terénu. Struktura dat je vyjád-

řena v histogramu vytvořeném v prostředí ArcGIS Pro (Obr. 26). 

Obr. 26 – Histogram nadmořských výšek závodů 

Obr. 25 – Graf vzdálenosti míst startů od měst s více než 30 000 obyv. 
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Průměrná nadmořská výška startu závodu je 389,4 metrů, značný vliv na průměrnou 

nadmořskou výšku měl poměrně velký počet závodů od organizátora Gladiator race, který 

pořádá v Česku nejvíce závodů a lokalizuje je především do níže situovaných míst, často do 

oblasti Polabí. Nejníže položeným závodem byl Gladiator race Brno s nadmořskou výškou 

206 metrů, naopak nejvýše byl start závodu Predator race na Eduardu, který měl hodnotu 

nadmořské výšky 893 metrů.  

Dále byla zjišťována série s nejvyšší nadmořskou výškou. V roce 2019 měla nejvýše 

položené starty série Predator race, na níž závodníci startovali v průměru ve 563 metrech 

nad mořem. 

7.3 Účastníci závodů 

7.3.1 Dle pohlaví  

Složení účastníků závodu je na mnoha závodech velmi podobné. Kromě jediné vý-

jimky, závodu Gladitor race Český ráj s 51,1 % startujících žen, převažovali na všech muži, 

největší rozdíl mezi počty mužů a žen byl na nadprůměrně dlouhých nebo naopak krátkých 

závodech, v průměru však na českých překážkových bězích startovalo 65,9 % mužů a 34,1 

% žen. 

  

Obr. 27 – Diagram podílu účastníků podle po-

hlaví 
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7.3.2 Dle věku 

Pro zjištění složení účastníků závodu podle věku bylo potřeba vycházet z výsledko-

vých listin závodů, kde jsou kromě času uvedené i roky narození. Jelikož by nebylo časově 

možné takto zjistit data ze všech závodů, a navíc někteří pořadatelé ročníky narození ne-

zveřejňují, bylo vybráno 9 závodů různých délek a od různých organizátorů, z nichž byla 

data zpracována. Konkrétně to byly závody: Spartan Sprint Dolní Morava, Urban challenge 

raha, Beton race, Wilsonka race, Geroy, Heroes race, MAD race, Predator race Bolevák a Be-

roun race. Data se vztahují jen k dospělým závodům, dětské závody do tabulek zahrnuty 

nebyly. Ze všech účastníků bylo 70 % z nich ve věku mezi 20 a 39 lety, naopak účastníků 

starších 60 let bylo pouze 0,2 %. 

 

  

Obr. 28 – Graf složení účastníků podle věku 
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8 ZÁVĚREČNÁ DISKUSE 

Jak již bylo řečeno v kapitole 4, časově poměrně velkou část práce jsem strávila hle-

dáním a shromažďováním všech dat. Velmi krátce po dokončení sběru dat však byly téměř 

všechny závody konané mezi březnem a červnem 2020 kvůli pandemii koronaviru zrušeny 

nebo přesunuty na jiné datum. Vzhledem k omezeným časovým možnostem jsem, bohužel, 

již nestihla tyto datumy zaktualizovat, pokud bych měla času více, pak bych tak ještě uči-

nila. Tento problém se týká především evropských závodů zobrazovaných ve webové ma-

pové aplikaci. 

Finální grafické úpravy tištěného výstupu práce jsem původně chtěla všechny pro-

vést v programu Inkscape, v němž jsem vytvořila i grafické obrázky závodníků, které byly 

do výsledného výstupu přidány. Tento program jsem chtěla zvolit především kvůli faktu, že 

jsem v něm pracovala již v minulosti, a tudíž pro mě byla tvorba v něm snazší než v jiných 

grafických programech. Mapy, které jsem však do programu Inkscape naimportovala, nešly 

nijak editovat a velmi výrazně zpomalily chod celého programu, proto jsem byla nucena 

najít vhodnější software na výslednou úpravu. Nakonec jsem vybrala již zmiňovaný pro-

gram Adobe Illustrator 2020, v němž bylo možné mapy po jednotlivých prvcích editovat, 

upravit legendu, přidat obrázky apod. 

Doufám, že se mi cíl práce podařilo splnit a výstupy práce vhodně představují pře-

kážkové běhy i osobám, které tomuto sportu nevěnují a téma pro ně bylo nové. Zároveň 

bych byla ráda, pokud by především mapa evropských závodů, publikovaná ve webové ma-

pové aplikaci, posloužila jako zdroj informací nejen pro začínající závodníky. Především 

v Polsku se nedaleko hranic s Českem pořádá poměrně velké množství závodů, o kterých 

spousta českých závodníků neví a jejich vizualizací na mapě je možné jim tyto akce přiblížit. 
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9 ZÁVĚR 

Cílem práce bylo vytvoření tištěného a elektronického kartografického výstupu, 

které budou představovat téma překážkových běhů. 

Po shromáždění všech potřebných dat o překážkových bězích byla tato data naim-

portována do programu ArcGIS Pro, kde byl tvořen tištěný výstup práce, finální grafické 

úpravy byly následně provedeny v programech Inkscape a Adobe Illustrator. Obsah tištěné 

části tvoří 3 mapy, první z nich je mapa ČR v měřítku 1 : 1 500 000, v níž jsou pomocí lokali-

zovaných diagramů zobrazeny počty účastníků překážkových běhů a jejich genderový po-

díl. Druhou mapou je kartogram reflektující počty závodů v evropských zemích v závislosti 

na výši částky poslané ze státních rozpočtů na sport a rekreaci. Tato mapa je v měřítku  

1 : 75 000 000. Třetí mapou v tištěné části práce je nepravý kartogram znázorňující celkový 

počet závodů na 100 000 obyvatel krajů ČR v měřítku 1 : 7 000 000. Kromě hlavních kompo-

zičních prvků obsahuje výsledná tištěná část práce i doplňkové obrázky závodníků na pře-

kážkách a krátké vysvětlení „co jsou překážkové běhy“. 

Druhým výstupem práce je webová aplikace blíže představující problematiku pře-

kážkových běhů. Webová aplikace byla vytvořena v prostředí ArcGIS Story Maps, pro tvorbu 

byla zvolena šablona Story Map Journal, která umožňuje prezentovat příběh pomocí posuv-

ného panelu. Data byla nejprve nahrána z programu ArcGIS Pro jako hostovaná vrstva prvků 

(Feature Layer) do prostředí ArcGIS Online, kde byly vytvořeny mapy, které tvoří výslednou 

Story Map.  Aplikace obsahuje celkem 5 map – mapu českých překážkových závodů sezóny 

2019, mapu tréninkových skupin v ČR, mapu evropských závodů, v nichž je možná kvalifi-

kace na Mistrovství Evropy, mapu závodů série Spartan v Evropě a ukázku tratě závodu Brno 

Spartan Winter Sprint, který se konal 8.2.2020. 

Pro práci byla použita vektorová geodatabáze ArcČR 500 v. 3.3 a databáze Data200, 

dále data Eurostat a veřejně dostupná data o závodech. 

Výsledná tištěná mapa je přílohou této práce, webová aplikace je dostupná na  

adrese:  https://arcg.is/1uTnuy   

https://arcg.is/1uTnuy
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